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1.1 GETTING STARTED

The Synthesis Tool was developed using Microsoft® Excel 2000. While the module will
operate with older versions of Excel, it functions best with Excel 2000 or later. Some of the
Excel basics are outlined in the steps below. Before you use the Synthesis Tool, make sure
your computer meets the system requirements. In order to install and run the Synthesis
Tool, you must have:

e IBM-PC compatible computer with the Windows 95 operating system or later;

e Microsoft® Excel 1997 or later, with calculation set to automatic and macros
enabled;

e Hard drive with at least 20MB free; and
e Monitor display setting of 800 x 600 or greater.

Microsoft Excel Settings

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to
automatic calculation. To check this setting, launch Microsoft Excel before opening the
Synthesis module. Go to the Tools menu and select “Options...” Click on the “Calculations”
tab and make sure that the radio button next to “"Automatic” is selected, and then click on
“OK" to close the window. The security settings (discussed next) can also be adjusted at
this time.

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to
automatic calculation. Go to the Formulas ribbon and select “Calculation Options.” Make
sure that the box next to the “"Automatic” option is checked from the pop-up menu.

Microsoft Excel Security

Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security
set to medium (recommended) or low (not recommended). To change this setting, launch
Microsoft Excel before opening the Synthesis module. Once in Excel, go to the Tools menu,
click on the Macro sub-menu, and then select “Security” (see Figure 1). The Security pop-
up box will appear. Click on the “Security Level” tab and select medium. When set to high,
macros are automatically disabled; when set to medium, Excel will give you the choice to
enable macros; when set to low, macros are always enabled.

When Excel security is set to medium, users are asked upon opening the module whether to
enable macros. Macros must be enabled in order for the Synthesis module to work. Once
they are enabled, the module will open to the control worksheet. A message box will
appear welcoming the user to the module. Clicking on the “x” in the upper-right-hand
corner of the message box will close it.

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security
Warning appears above the formula box in Excel when the Synthesis module is initially
opened. The Security Warning lets the user know that some active content from the
spreadsheet has been disabled, meaning that Excel has prevented the macros in the
spreadsheet from functioning. Because SIT needs macros in order to function properly, the
user must click the “"Options” button in the security message and then select, “Enable this
content” in the pop-up box. Enabling the macro content for the SIT in this way only enables
macros temporarily in Excel but does not change the macro security settings. Once macros
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are enabled, a message box will appear welcoming the user to module. Click on the “x” in
the upper right-hand corner to close the message box.

If the Security Warning does not appear when the module is first opened, it may be
necessary to change the security settings for macros. To change the setting, first exit out
of the Synthesis module and re-launch Microsoft Excel before opening the Synthesis
module. Next, click on the Microsoft Excel icon in the top left of the screen. Scroll to the
bottom of the menu and select the “Excel Options” button to the right of the main menu.
When the Excel Options box appears, select “"Trust Center” in left-hand menu of the box.
Next, click the grey “"Trust Center Settings” button. When the Trust Center options box
appears, click "Macro Settings” in the left-hand menu and select “"Disable all macros with
notification.” Once the security level has been adjusted, open the Synthesis module and
enable macros in the manner described in the preceding paragraph.

Viewing and Printing Data and Results

The Synthesis Tool contains some features to allow users to adjust the screen view and the
appearance of the worksheets when they are printed. Once the tool has been opened, you
can adjust the zoom by going to the Module Options Menu, and either typing in a zoom
percentage or selecting one from the drop-down menu. In addition, data may not all
appear on a single screen within each worksheet; if not, you may need to scroll up or down
to view additional information.

You may also adjust the print margins of the worksheets to ensure that desired portions of
the Synthesis Tool are printed. To do so, go to the File menu, and then select “Print
Preview.” Click on “Page Break Preview” and drag the blue lines to the desired positions
(see Figure 2). To print this view, go to the File menu, and click “Print.” To return to the
normal view, go to the File menu, click “Print Preview,” and then click *Normal View.”
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1.2 SYNTHESIS TooL OVERVIEW

The Synthesis Tool was designed as a companion to EPA’s State Inventory Tool (SIT), which
estimates state-level emissions for 1990-2020. Users who have completed the historical
emission estimation process using the SIT modules can import the historical emissions into
the Synthesis Tool to compile the time series for all modules from 1990 through 2020.
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1.2.1 Data Requirements

Before using this module, the user should conduct greenhouse gas inventories for all
applicable sources using the individual sector modules. The individual sector modules
include the following: CO2 from Fossil Fuel Combustion, Electricity Consumption, Stationary
Combustion, Mobile Combustion, Coal Mining, Natural Gas and Oil Systems, Industrial
Processes, Agriculture, Land Use, Land-Use Change and Forestry, Municipal Solid Waste,
and Wastewater.

After completing each sector inventory, the user should export the data using the “Export
Data” button provided in the final step of each sector module. The modules will then create
an output file using a default file name. Please do not change the file names or alter the
output files in any way. Once the output files have been generated, the Synthesis module
can then be used.

1.2.2 Tool Layout

Because there are multiple steps to complete within the Synthesis Tool, it is important to
understand of the Tool’s overall design. The layout of the Synthesis Tool is presented in
Figure 3.

Figure 3. Flow of Information in the Synthesis Tool
Control Worksheet Module Worksheets (for Reviewing Data)

1. Choose a State
2. Locate Output File, Import, and Review Data for Each Module:

CQ from Fossil Fuel Combustion ™ 7~ CO, from Fossil Fuel Combustion
Indirect COs, from Electricity Consumption Indirect COs, from Electricity Consumption
Stationary Combustion Stationary Combustion
Mobile Combustion Mobile Combustion
Coal Mining Coal Mining
Matural Gas and Oil Systems > ‘< Matural Gas and Oil Systems
Industrial Processes Industrial Processes
Agriculture Agriculture
Land-Use Change and Forestry Forest Management and Land-Use Change
funicipal Solid Waste funicipal Solid Waste
Wastewater S \_Wastewater
3. Select Units and View Summary Worksheets €———> Summary Data

1 By Sector: presented in table and graphical formats
| By Gas: presented in table and graphical formats
| By Intensity: presented in table and graphical formats

1.3 METHODOLOGY

This section provides a guide to using the Synthesis Tool to import emission estimates from
completed modules of the SIT. The following three steps describe how to import and view
the estimates provided by the eleven SIT modules: (1) select a state on the control
worksheet; (2) locate output file, import, and review data for each module; (3) select units
and view summary information.
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Step (1): Select a State on the Control Worksheet

To begin, select the state you are interested in evaluating. By selecting a state, the rest of
the tool will automatically reset to reflect the appropriate state default data and
assumptions for use in subsequent steps of the tool.

Step (2): Locate Output File, Import, and Review Data for Each Module

This step involves importing the output files containing emission estimates from the
individual modules. While the CO2 from Fossil Fuel Combustion (CO2FFC) module will be
used as an example of how to import and review data, the importing process is identical
across for all eleven SIT modules.

On the control worksheet, select the “"Get CO2 from Fossil Fuel Combustion Data” button.
Once this button is selected, you will be prompted to locate the summary file exported from
the CO2FFC module (called "CO2FFC_Summary”) as shown in Figure 4.

Figure 4. Example of Importing Data in the Synthesis Tool
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3. View the Summary Sheets:

S0 to Surmmary by’
Sector

So to Summary by
Intensity

S0 to Summary by
Gas

If the file is imported successfully, the current date and time will appear in the column titled
“Summary File Imported on”. This timestamp is useful to have if you are completing an
inventory on an annual basis and would like to know the last time data was imported into
the Synthesis Tool.

To review the data that was imported for a given module, click on the gray navigational
arrow to the right of the module you would like to review. The summary data worksheet by
sector for the CO:z from Fossil Fuel Combustion is shown in Figure 5. In each sector
summary worksheet, you have the option to enter total emissions data by gas (in
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MMTCO:zE) from ‘Additional Emissions Source(s)’ if you have emission sources that are not
already covered by the sector module that you would like to include. Any additional
emissions are pulled into the Summary by Sector and Summary by Gas worksheets. To
return to the control worksheet, click on the gray navigational arrow.

Figure 5. Example of CO2FFC Summary Worksheet

Summary of €CO2 Emissions from Fossil Fuel -
Combustion in Florida (MMTCGOZ2E) Sheet g::l:'l::otlo

This tab surrmarizes emissions from fassil fuel combustion in million metric tons carbon dicxide equivalent (MMTCOLE) using emissions results T O T
uded

Emizsions from an addifionzl emissions source can be entered (in MMTCOLE) in the "Additionsl Emissions Source’ row if your state has emission sources that are not slready inc
in the sector module. Any additional emissions are pulled into the Summary by Sector and Summarny by Gas workshests.

Emissions [MMTCO, Eq.) 1990 1991 1992 1993 1994 1995 1996 1997 1998 1999 2000
| Fesidential | 154 158 175 167 157 149 186 137 145 142 152
Coal 0.00 0.00 oo nm om 0.00 0.00 - 0.00 0.00 0.00
Petroleum 079 0.83 0.30 0.85 074 0E7 063 063 065 05 063
Matural Gas 074 075 ix:1) 08 [IX:x] nsz2 0.95 073 073 07E [IR:E]
Clther - - - - - - - - - - -
Commersial 526 598 597 478 435 424 417 164 156 164 481
Coal 0.0 0.00 0.03 0.03 0.04 0.00 0.00 . 0.01 0.01 0.02
Petrolzum 417 370 251 236 183 205 170 159 145 162 198
Matural Gas 208 228 243 233 238 228 247 205 21 20 p:1)
Other - - - - - - - - - - -
Industrial 1.9 129 12.90 1415 14.95 16.19 15.04 15.11 15.29 15.39 1447
Coal z8 2EF an 303 302 10 za7 14 za7 276 298
Petroleum 428 367 4E7 531 430 595 539 4939 655 625 538
Matural Gas 487 437 513 5.81 7.03 EAK] 768 5] ] 737 B2
Oither - - - - - - - - - - -
Transpartation 2149 T8 7291 78.73 #4.26 F648 87.41 a0.k60 3203 3478 100.95
Coal - - - - - - - - - - -
Fetroleum 2133 7635 TIEE TEAT 2384 2605 708 a0.27 a120 3439 10051
Matural Gas 016 0.20 0.26 0.26 03z 043 0.35 033 0.23 040 044
Oither - - - - - - - - - - -
Eletric: Utilities 85.19 a1.24 89.17 93.35 9508 9714 10188 105,85 11634 266 114.95
Coal 55.94 6765 57.08 G766 5250 E0B3 EE.25 BEES 6628 E319 E7.03
Petralzum 131 2279 21.21 2652 25.21 16.71 1759 2051 210 2933 27.95
Matural Gas 10.14 Il n nan 1 19.81 18.04 1869 1797 2014 19.97
Clther - - - - - - - -
International Bunker Fuels - Enter -OPtIOnaI ooz on3 onz n.n4 nonz 0oz
Fretraleumn - Additional iliH] 003 00z 004 0oz 0.0z
TOTAL 186.43 181 Emissions Source 205.66 2119 21659 22870  227.90 23672
Coal 58.77 E3.73 £3.23 §3.80 §9.27 E5.95 70.03
Petrolzum 109.67, 107.98 109.97 264 1674 1145 Nn245 1n2.02 13160 327 136.46

atural Gas 18.00 1353 14.35 2154 3043 2350 2878 2783 06T 3022
Oither - - - - - - - - - -

Additional Emizsions Source

Step (3): View Summary Information

Once the data from all of the modules has been imported, you can view estimates in
MMTCO:E on the final summary worksheet. A summary of the modules by sector, gas, or
intensity (per capita and by gross state product) is provided within the Synthesis module.
An example of the sector summary worksheet is shown in Figure 6. In addition, the results
are displayed in graphical format at the bottom of the summary worksheets.
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Fii ure 6. Exami le of Summar‘ Worksheet b‘ Sector
S state Inventory Tool - Synthesis Madule

i Ele  Edit  Modue Options
Summary of GHG Emissions by Sector in Colorado oo o @il || o B Sy h> Ba to Summary by
(MMTCOZE) Sheet Gas Intensity
Emissions (MMTCOZE) 1990 1991 1992 1993 1994 1995 1996 1997 1998 1999 2000
Energy 590,91 68827 69663 al0.60 612,73 614,75 661,87 682.00 683.87 671,60 695,36
£, from Fos=il Fuel Combustion BEE4E hE86.683 B94.04 609,14 611,29 613.32 660,34 68043 682,39 670.03 693,81
Stationary Combustion 144 149 146 144 143 1563 156 148 147 155
#hobile Combustion - - - - - - -
Caal Mhining - - Summary - - - - - -
Netural ez and Oil Systans - - by Sector
Industrial Processes r_ T T T 1221 13,16 177l 18.10 17.90 19.06
Agriculture % 42.61 43.10 458,94 48,03 4749 471z 48,27 46,80 45,07 44.13
Enteric Fermentation . 19.88 2020 20,93 2062 1948 19.64 19.31 18.96
Manure Management 370 387 375 367 369 .84 376 .97
Rice Cultivation 132 187 141 132 115 W) 115 109
Agmcu\tuml Sail fhanagement 2102 2176 2139 2149 2092 20.80 20.83 20.09
Burning of Agrmultum\ Crop Waste n.oz n.oz n.oz 0.0z 0.0z 0.0z 0.02 0.02
LULUCF
Waste 133 136 139 141 144 147 149 156
Hunicipal Solid Waste
Wastewater 126 128 131 133 136 139 141 144 147 149 166
Gross Emissions 643.43 é41.32 $50.70 667.60 672.90 675.85 723.57 746.41 745.99 735.97 760.10
Sinks - - - - - - - - - - -
Net Emizsions 643 .43 641.32 650.70 667.60 672.90 675.85 723.57 746 .41 743.99 735.97 76010
* Emissions from Electricity Consumption are nat included in totals in arden to avoid double counting with Fossil Fuel Combustion estimates.

1.4 CONCLUSION

Once the results of all eleven modules are imported into the Synthesis Tool, you will have a
complete inventory for your state. These results may be used to create an inventory
document, if you so desire. In addition, you may use these historical estimates as the basis
for emission projections in EPA’s Projection Tool. For instructions on using the Projection
Tool, please consult the Projection Tool User’s Guide.
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